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This help file is in support of the WIPackage File Builder from Stillwater Systems, Inc.    The WIP File 
Builder program (WIPBuilder) is designed to build WinIntelligentPackage (WIP™) files for software 
distribution purposes.    As a creator of WIP files you will be able to send your customers, colleagues,
friends and neighbors a single, compressed package file that contains other software that you wish 
to provide to them.    But there is more...lots more!    

First of all, the compression algorithm used in the construction of WIPackage files is one which most 
of us are very familiar with, PkZip, pioneered by PkWare, Inc.    This ensures the optimum in 
compression ratios.    The primary difference between ZIP and WIP files is that a WIP file has the 
ability to distribute it's file contents to the directories specified by the WIP file creator.    The recipient 
of any WIP file simply executes the WIPackage File Distributor program by double-clicking a WIP file 
from File Manager.    The WIP file is automatically unpacked and distributed to the appropriate 
locations.    No longer will you have to provide a README or INSTALL text file to instruct the recipient
on how to place the files that you have provided.    It's really that simple.    Yes, it's a ZIP file with a 
brain!

Please select any of the options below to learn more about WIP files.

What is New in Version 1.2
What was New in Version 1.1
Creating WIPackage Files
Updating WIPackage Files
Reviewing WIPackage Files
Deleting WIPackage Files
All About Destination Paths
Other Distribution Options
Answers to Common Questions
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Warranties and Disclaimers
How to Register WIPBuilder
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What is New in Version 1.2
WIPBuilder 1.2 includes the following enhancements from version 1.1:

· The ability to set the existing file overwrite option by file (see the button labeled "Set 
Overwrite Options" in main dialog)

· Added command line processing option.    A parameter file can now be constructed (see 
$sample$.wcl in the WIPBLDR directory) that provides instructions to WIPBuilder to 
automatically construct a single or multiple WIP files, depending on the parameters 
provided.    Be sure to associate the file extension (your choice) with WIPBLDR.EXE.    The 
extension of .WCL is used only as a sample and is not mandatory.    The association will 
allow you to run the parameter file (or double-click the paramter file from File Manager) to 
automatically launch WIPBuilder.



What is New in Version 1.1
WIPBuilder 1.1 includes the following enhancements from version 1.0:

· Ability to convert a WIP file into a standard ZIP file (like performing a lobotomy on a WIP 
file!)    See the "Convert to ZIP" option on the File menu

· Expanded comment dialog with ability to include a message to all recipients by enclosing 
message text in [    ] characters (WIPDistributor 1.0c required by recipients)

· Improved "About" dialog box for registered users
· Credit card registration available thru PsL, product id# 14047



Creating WIPackage Files
NOTE:    Please see the screen sample at the bottom of this topic.    It contains hot-spots that will 
reveal much more information on the main dialog window.

This topic will explain how to create a WIPackage file.    The main function of WIPBuilder is to create 
WIP files.    The dialog facilitates the construction of a WIP file contents list.    Once the list is 
constructed and other options have been selected, WIPBuilder will pack all the designated files into 
the WIP file, including the instruction set for distributing the files on the recipient's PC.

Here is a list of steps required to create a WIP file:

1 Select the 'Create' option from the 'Package' menu or press F2
2 Specify the name of the WIP file to be built
3 Define a default destination for the files in the WIP file (optional)
4 Define a password to encrypt the WIP file (optional)
5 Enter a comment for the WIP file (optional)
6 Build the WIP file content list
7 Build the WIP file

Here are some examples of the dialogs you will encounter while creating WIP files.

To create a new WIP file, hit F2 or select 'Create WIPackage File' from the 'File' menu as show here.

The first thing to do is specify the WIP file name.    The following dialog is presented:



If you select a WIP file that already exists, you will asked to verify your actions.    You can rebuild any 
existing WIP file from scratch but if you really want to update the file, use the 'Update' option (F3) 
from the 'File' menu.    

You may also review the contents of an existing WIP file by clicking on the 'Review' button.

Here is a picture of the main WIPBuilder dialog.    The picture contains hot-spots that will reveal more
information about the dialog window.





Updating WIPackage Files
Existing WIP files can be updated or rebuild from scratch using WIPBuilder.    To update an existing 
WIP file, press F3 or select the 'Update' option from the 'File' menu as shown here:

The following dialog will be displayed to help you find the desired WIP file:

After you have selected the WIP file to update, the main dialog will appear with the contents of the 
WIP file already loaded in the various fields as shown below.    You can add or remove files from the 
package, change destination paths, add a password or add a comment.    Simply click on the 'Build' 
button to re-construct the file.





Reviewing WIPackage Files
The contents of a WIP file can be reviewed from a few different places.    When you select an option 
from the 'File' menu you can choose to review a WIP file as shown here:

After you have opened a WIP file for update, you can click on the 'Review Pkg File' button in the 
main dialog window.    

After you build a new WIP file you will be presented with the option to review the newly created WIP 
file.



Deleting WIPackage Files
Do delete an existing WIP file, press F4 or select the 'Delete' option from the 'File' menu as shown 
here:

The following dialog box will be displayed to help you find the WIP file to delete.

After selecting the appropriate WIP file, click the OK button to proceed with the deletion.



All About Destination Paths
Each file in a WIPackage can be directed to it's own unique destination or to the same as other files 
in the package.    The destination path specification can be either a full directory specification, a 
pointer to an INI entry that contains the path, a recipient-selected path, the recipient's Windows 
directory or the recipient's Windows\System directory.

When you start to create a new WIP file, you may specify a default destination path.    This path will 
be used as the default for files as they are included in the WIP package content list.    Files are 
included in a package by clicking on the > or >> buttons or by dragging and dropping files from File 
Manager. The file's source path is automatically set as the destination path.    If you hold the 'Ctrl' key
down while selecting files then the default destination path is used as the destination path for the 
files.    The default destination path will be used when an INI entry lookup fails on the recipient's PC.   
Also, this path is presented as the default value when a the user is asked to supply a destination 
path for those files tagged with $RECIP_SELECTS as their destination.    

The following dialog appears when you choose to define a package default destination path.    The 
picture contains hot-spots that will tell you more about the dialog.

You can change the destination path of any file in the contents list by selecting the file then clicking 
on the 'Set Dest Path' button found to the right of the contents list.    If you select multiple files, the 
destination path will change for all selections.

To review the destination paths, click on the 'Review Dest Paths' button found to the right of the 



contents list.    The following recap screen will be presented.    

Notice the key words of $WIN, $WINSYS and $RECIP_SELECTS.    The WIPDistributor will ask the 
recipient to specify a single path for all the files tagged with $RECIP_SELECTS.    The WIPDistributor
determines the recipients Windows and Windows\System directories for placement of those files.    
The path specs that start will INI:\ will direct the WIPDistributor to obtain an actual path found the 
designated entry.    For example, given the following ACTWIN2.INI file on the recipients PC:

[Paths]
Database=C:\ACTWIN\DATABASE
Template=C:\ACTWIN\TEMPLATE
Docs=C:\ACTWIN\DOCS

the spec of INI:\ACTWIN2.INI\PATHS\DATABASE would evaluate to C:\ACTWIN\DATABASE
the spec of INI:\ACTWIN2.INI\PATHS\DOCS would evaluate to C:\ACTWIN\DOCS

If an INI lookup fails during the distribution process for any reason, the default destination path will be
used.



Other Distribution Options
Three additional features of a WIPackage File are the ability to add program groups and icons to 
your recipients Windows desktop, add file type associations to your recipient's registry, and to update
INI files on your recipient's PC.

All the options require the WIP file creator (that's you!) to build parameter files and include them in 
the WIP file.    Two sample parameter files were included with the WIPBuilder installation package, 
$SAMPLE$.ADX and $SAMPLE$.IUX.    (we had to use X as the last character so that the file 
contents were not actually processed when the WIPBuilder package was distributed.    Make sure 
you use the .ADI and .IUP extension when you construct your own Add Icons and INI Update files.

*Note:    when you include .ADI and/or .IUP files in a WIPackage, do not worry about the associated 
destination paths.    The files will not be distributed on the recipients PC.

For example, you can create a file named XXXX.ADI (Add Icons parameter file) in Windows Notepad
to look something like this:

[Group Info]
Group Name=A New Application
Group File=anewapp.grp
Num Items=4

[Item 1]
Command Line=?\anewapp.exe
Icon Title=A New App Program

[Item 2]
Command Line=c:\somedir\bogus.doc
Icon Title=Sales Proposal

[Item 3]
Command Line=?\readme.txt
Icon Title=Read Me

[Item 4]
CommandLine=
Icon Title=Demo Program
Action=Delete

Notice the ? in the command line for items 1 and 3.    This instructs the WIPDistributor to use a path 
specified by the package recipient in place of the ?.    Notice the Action parameter provided for Item 
4.    The default action is Add but you may also delete existing program items by including an 
Action=Delete line in your .ADI file.    The Action option is also available for deleting a group.    Simply 
include an Action=Delete line in the [Group Info] section.

Note:    Each .ADI file can only accommodate one program group with many program items, though 
your WIP package may contain multiple .ADI files.    You must name the Add Icons parameter files 
with an extension of ADI.

You can also use an .ADI file to add new file type associations to the recipients registration database.



File type associations will enable certain files to be double-clicked or "Run" without the need of a 
program name to be specified.    Here is a sample of the entries required to update the registration 
database:

[Associate Info]
num items=2
(how many association requests follow)

[Associate 1]
Long Name=Test.New.Assoc
Short Name=TestNew
Program Name=c:\windows\newprog.exe
Extension=xxx
(adds association of .xxx files to c:\windows\newprog.exe)

[Associate 2]
Long Name=Sync.ADI.Files
Short Name=SyncADI
Program Name=notepad.exe
Extension=adi
(adds association of .adi files to notepad.exe)

To execute INI file updates, you can create a file name ZZZZ.IUP (INI Update parameter file) to look 
something like this:

[Update Control]
NumUpdates=2

[Update 1]
file=wipbldr.ini
section=Information
keyword=WorkingDirectory
value=?\workarea\

[Update 2]
file=wipbldr.ini
section=Information
keyword=HoldDirectory
value=?\holdarea\

Notice the ? in the value lines.    This instructs the WIPDistributor to use a path specified by the 
package recipient in place of the ?.

Note: You only need a single .IUP file per WIP package.    Be sure to enter the correct value in the 
NumUpdates line.    You must name the INI Update parameter file with an extension of IUP.



Answers to Common Questions

Can I include WIP files within other WIP files?
Can I distribute WIPDistributor to anyone I want?
Can a WIP file replace a custom developed setup program?
Can a WIP file be EMailed to recipients?
Are WIP files compatible with PkZip?
Can a WIP file be unzipped using PkUnZip?
Can WIPBuilder create a ZIP file?



Yes, definitely.    A WIP file is treated like any other file so you can include WIP files within WIP files.    
This is a good way for you shareware developers to include a license file with the software.    The 
license file can be put into a password encrypted WIP file that is then included in the main WIP file.    
Upon registration you can simply EMail your customer with the password to the encrypted WIP 
license file.



Please do!    We want everyone to have a copy of WIPDistributor.    The README.TXT that came 
with this package has a section on distributing WIPDistributor.    As you experienced when you ran 
the WIPDistributor setup program, we included the WIPBuilder application in a WIP file named 
AUTODIST.WIP.    The setup program saw the AUTODIST.WIP and immediately launched 
WIPDistributor to unpack and distribute it's contents.    You can do the same by building a WIP file 
named AUTODIST.WIP, include it with the WIPDistributor setup files and you're all set!



Well, possibly.    If your application setup requirements include only the distribution of files, the 
addition of program groups and icons and INI file updates, then chances are good that you a WIP file
can handle the requirements.    As you experienced, our setup routine for WIPBuilder was fully 
contained in a WIP file named AUTODIST.WIP.



Yes, by all means!    This is a great way to distribute files in a corporate environment.    Just give 
WIPDistributor to everyone and you'll be all set.    WIP files have been successfully tested in a 
Window NT/AS and MSMail environment.    It's even great for remote users accessing a network via 
RAS.    Other networking environments should also work fine.

When a WIP file is sent as an MSMail attachment, the recipient can simply double-click the 
attachment icon in the letter, and WIPDistributor will take off and do it's thing!



In general, yes.    The compression library used in creating WIP files are directly compatible with 
PkWare's PkZip and PkUnZip utilities.    A more recent version of PkZip (2.04g) supports a new 
compression algorithm call 'deflating'.    This and previous algorithms are supported by 
WIPDistributor and WIPBuilder.



Yes, the primary contents of a WIP file can be unzipped with PkUnZip and other ZIP utilities without 
any problem.    A WIP file does contain some information that we at Stillwater Systems, Inc. consider 
to be proprietary and is copyrighted.    That information can not be unzipped with PkUnZip or any 
other ZIP utility in DOS or Windows.



In essence, WIPBuilder is creating a ZIP file but with some additional, much needed intelligence.    
You can take any WIP file and rename it with a ZIP extension and you'll have a ZIP file.    (Although, 
take a look at the answer to the above question)    

With version 1.1 you can convert a WIP into a ZIP file using the "Convert..." option from the File 
menu.    This method will avoid problems with our proprietary information.



All About WIPackage File Distributor
As you may have already experienced, the WIPackage File Distributor (WIPDistributor) is packed 
with some great features.    Not only does it contain the "smarts" to handle WIP files, but it's also a 
great, quick unzipper!    At setup time the user can choose some options that can later be edited in 
the WIPDIST.INI file.    Following is a recap of the main features of WIPDistributor.

· Unpacks and distributes the contents of any WIP file
· Has version number checking capabilities
· Optionally provides the user with the ability to preview the contents of a WIP file, 

including detailed file information, specific file review capabilities (such as looking at a 
README) and single file unpacking BEFORE the distribution occurs

· Creates a complete and detailed log file for every WIP distribution
· Provides the ability for a user to unpack password-encrypted WIP files
· Can add or delete program groups and items to/from the recipients Windows desktop
· Can update INI entries on the recipients PC
· Can add file type associations to the recipients registration database
· Will unzip any ZIP file into its own, unique sub-directory
· Provides a "double-click, no-brainer" method for software distribution
· Costs nothing, zero, zilch, $0, absolutely FREE!



Credits and Acknowledgments
The compression library used for WIPBuilder and WIPDistributor is Compression Plus from 
MicroHelp, Inc. originally developed by EllTech Development, Inc.    MicroHelp can be 
contacted at:

MicroHelp, Inc.
4359 Shallowford Industrial Parkway
Marietta, GA    30066
FAX (404) 516-1099
Ph# (800) 922-3383

This help file was built using VisualHelp from WinWare Inc.    WinWare can be contacted at:
 
WinWare Inc.
P.O. Box 2923
Mission Viejo, CA    92690
FAX (714) 586-9792
CompuServe: 70272,1656

The File Manager drag-n-drop capabilities were made much easier by the inclusion of the 
FMDROP VBX from Mabry Software.    Mabry Software can be contacted at:

Mabry Software
P.O. Box 31926
Seattle, WA    98103-1926
Ph# (800) 996-2279
Ph# (206) 634-1443
FAX (206) 632-0272

Special thanks to:

Steve de Carteret for his contribution of ideas to this project.
Bill Irving for his contribution during the testing phase.
Laurel Goyena for helping test the application.
Gateway 2000 for an awesome Pentium P5-90 on which WIPBuilder and WIPDistributor was 
written.
Microsoft Corporation for developing Visual Basic

WinIntelligentPackage, WIP and Synchronicity are trademarks of Stillwater Systems, Inc.
Windows is a trademark and Visual Basic is a registered trademark of Microsoft Corporation.
Compression Plus is a trademark of EllTech Development, Inc.
PkZip is a trademark of PkWare, Inc.



All other trademarks belong to their respective companies and owners.

This software and documentation 
(c) Copyright 1995 Stillwater Systems, Inc.    All rights reserved.



Warranties and Disclaimers
DISCLAIMER:    

To the maximum extent permitted by applicable law, Stillwater Systems, Inc. disclaims all warranties, 
either express or implied, including but not limited to implied warranties of merchantability and fitness
for a particular purpose.

NO LIABILITY FOR INCIDENTAL DAMAGES: 

To the maximum extent permitted by applicable law, in no event shall Stillwater Systems, Inc. be 
liable for any damages including but not limited to loss of business profits, business interruption, 
information loss, or any other loss resulting in the use or inability to use this product.



Stillwater Systems, Inc.

32248 N.E. 94th Street
Carnation,    WA    98014
CompuServe: 72643,604

To register WIPBuilder, please use SWREG in CompuServe, GO SWREG.    The ID# for 
WIPBuilder is 5095.    You may also send a check for US$45.00 to the address above.    If you're
from outside the U.S., add an additional $5.00.    Please include your EMail address on the 
check.    To pay by credit card please the PsL at 1-800-242-4775 and register product number 
14047.    Please note that PsL is only to be called to register WIPBuilder using a credit card.    
All support questions must be EMailed to Stillwater Systems, Inc. at 72643,604.

If you're looking for a more complete software distribution system, ask us about 
Synchronicity.    With WIP files as it's nucleus, Synchronicity provides the systems 
administrator with a database application that builds WIP packages, facilitates the distribution
of the packages to your user community and then tracks the status by package and recipient.
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All About the WIPDIST.INI File
Here is a sample snapshot of a typical WIPDIST.INI file:

[Information]
UnpackDirectory=C:\WINDOWS\UTILS\WIPDIST\WORKAREA\
(just a work area)

LogDirectory=C:\WINDOWS\UTILS\WIPDIST\LOGS\
(where all the .log files are stored)

BackoutDirectory=C:\WINDOWS\UTILS\WIPDIST\BACKOUT\
(work area for backout package creation)

[Options]
PauseAtStartup=Yes
(presents the user with a list of the WIP file contents prior to 
distributing)

AutoDeleteAfter=Yes
(can be used to automatically delete the WIP file after successful 
distribution.  Works only for WIP files residing on C: drive)

EncryptionKey=
(can be set to hold a standard encryption key to be used with all WIP 
distributions)

The WIPDistributor program also has a command line option available.    If "-a" or "-A" (auto-deliver 
flag) is found following the WIP filename, the WIP distribution occurs without user intervention or 
input required.    For example, from Program Manager or File Manager:

File, Run    C:\WORKAREA\NEWSTUFF.WIP -A

When the "Auto-deliver" flag is used, any messages that would have been presented to the user is 
written to a special log file named WDyymmdd.LOG (where yymmdd is the current date) and can be 
found in the log directory specified in the WIPDIST.INI file.



Build WIPackage File
Click this button to pack the selected files into the specified WIP file.    Be sure to review the 
destination paths before you build.    Upon completion of the build, you will be given the option to 
review the new constructed WIP file.    The WIP file will be ready for distribution (even if you choose 
not to review it).



Clear List
Click this button to completely clear the WIP content list.



Clear Selected
Click this button to clear all selected files from the WIP content list.



Default Destination Path
This box will display the default destination path for the WIP file contents.



Path Finder
Use the drive and directory list box to find the path that you want to specify as the destination path.    
You may enter a new directory name in the box at the bottom.    You can choose to create the new 
directory but it is not required.



Exit WIPBuilder
Click this button to exit the program.



File Menu
This menu provides the options of creating, updating or deleting WIP files.    An 'Exit' option is also 
available.



Grab All Files
This button will pull all of the files in the list on the left into the WIP contents list.    If you hold the 'Ctrl' 
key down while clicking this button, the default destination path will be used as the destination path.   
If you do not hold the 'Ctrl' key down, the destination path for the files will be set equal to the file's 
source path.

Note:    You may also drag-n-drop files from File Manager.    The 'Ctrl' key works in the same way.



Grab Selected Files
This button will pull the selected files in the list on the left into the WIP contents list.    If you hold the 
'Ctrl' key down while clicking this button, the default destination path will be used as the destination 
path.    If you do not hold the 'Ctrl' key down, the destination path for the files will be set equal to the 
file's source path.

Note:    You may also drag-n-drop files from File Manager.    The 'Ctrl' key works in the same way.



Help Menu
The Help menu facilitates quick access to this help file.    You can choose to go to the Contents of the
help file or you can perform a keyword search.    The 'About' dialog box is also accessible from the 
Help menu.



INI Filename
This is where you enter the name of the INI file.    You should be confident that your recipients all 
have the specified INI on their PC.    If the INI file is not found then the default destination path will be 
used.



INI Keyword
This is where you enter the INI entry keyword value.    For example, the keyword here is "LAYOUTS".

[Some Section]
LAYOUTS=c:\someapp\stuff



INI Section
This is where you enter the INI entry section name.    For example, the section name here is "TEMP 
PATHS".

[TEMP PATHS]
database=c:\someapp\db
notes=c:\someapp\notes



Message Area
This area will display messages as the mouse moves around the screen.    Be sure to read the 
message.    They are very helpful!



Other Destination Directory Options
The $WIN option will direct the WIPDistributor program to determine the user's Windows directory 
and use it as the destination path.

The $WINSYS option will direct the WIPDistributor program to determine the user's Windows System
directory and use it as the destination path.

The $RECIP_SELECTS option (not available as the default) will direct the WIPDistributor program to
obtain the destination path from the recipient.    All files within a given WIP that are tagged with 
$RECIP_SELECTS will go to a single directory.    The recipient only specifies the path one time.



Overwrite Options
Designate here what the WIP Distributor routine should do when a file to be distributed already exists
in the target destination path.

The first option directs the WIP Distributor to use the internal version number of the two files to 
determine whether or not to copy the incoming file over the existing file.    The higher version number 
will take precedence.    If version numbers do not exist in either file, the file's date/time stamps are 
evaluated and the newer file will take precedence.    This is probably the best option in most cases, 
thus it is set as the default.

The second option directs the WIP distributor to use the file's date/time stamps.    The newer file will 
be take precedence.

The third option directs the WIP distributor to always overwrite existing files with the incoming file.    
Be careful with this option.

The fourth option directs the WIP distributor to always leave existing files intact. 



Password Encrypting a WIP File
You may choose to encrypt a WIP file with a password.    This will prevent unauthorized recipients 
from unpacking the WIP file.    If you are a shareware developer you can build a password encrypted 
WIP file that contains a license file for your software.    You can distribute the license WIP file with 
your product and then simply provide registered users with the password to the license WIP file.

Here are instructions on password encrypting a WIP file.

1 Create a WIP or select and existing one to update
2 Click on the 'Set Pkg Password' button (or Alt-W) and the following dialog will be 

displayed
3 Enter the selected password in both boxes then click on the 'OK' button
4 Click the 'Cancel' button if you decide not to use a password

WIPBuilder will check that you have entered the same value in both password boxes.



WIPackage File Comment
You may enter a comment of any WIP file.    This comment can be viewed by your recipients.    It may
also prove useful in documenting the contents of the WIP file.



WIPackage File Contents List
This list will contain all of the files that you select for inclusion in the WIP file.    The source path will 
be listed along with the name of each file.

Note:    You can use the directory and file lists on the left to select files for the WIP file or you can 
drag-n-drop files from File Manager.



Review Package File
When you have a WIP file open for update, you may click on this button to review it's contents.



Source Directory Tree
When selecting files to be included in the WIP file, use this directory list box to find particular 
directories on your PC.

Note:    You may also drag-n-drop files from File Manager.



Source Drive
When selecting files to be included in the WIP file, use this drive box to change drives on your PC.

Note:    You may also drag-n-drop files from File Manager.



Source Files
The contents of this list is based on the selections made in the above drive and directory lists.    You 
can use the > and >> buttons to grab files from this list for inclusion in the WIP file.    The 'Ctrl' and 
'Shift' keys can be used to select multiple files from the list.

Note:    You may also drag-n-drop files from File Manager.



Source File Pattern
Change the value to filter or expand the contents of the list below.    The '?' and '*' wild cards are 
allowed.



WIPackage Filename
This field will display the name of the WIP file that is being created or updated.



backout package
Not fully supported at this time.






